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English Manual

Dear HTML ImageMapper users,

On this site a new form of documentation for the software HTML ImageMapper is 
evolving. The contents of the HTML ImageMapper manual can be accessed here. 
Additionally you as the users of HTML ImageMapper are given the opportunity to 
contribute to this work of reference.

Many insights come from the daily work with a software. You as the users are 
invited to use this platform to share your experience and take advantage from the
contents others post here.

From time to time we will compile a PDF document from this forum so that users 
can access the contents off-line as well and print the documentation on paper. 
The PDF will be available for download and free of charge.

We are looking forward to your input.
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installation

HTML ImageMapper 10 - AJAX is an Internet-GIS-Extension for ArcGIS (ArcView, 
ArcEditor or ArcInfo) Version 9.0 or higher.

Uninstall all older versions of HTML ImageMapper.
Decompress the download file imagemapper10.zip with a double click on 
the file in the Windows Explorer. (E.g. with WinZip, free for download at 
http://www.winzip.com).

Double click on the setup.exe file in the Explorer.  The setup 
dialog will start automatically.
Read through the license agreement carefully and activate the checkbox 
next to "I accept". Then click "Continue".

5. Type in your name ("Licensed Name") and license key ("License Number").

Demo version: Type in the license key you received via e-mail after you 
downloaded the software. Should you not have your license key ready click 
"Obtain license key". Follow the instructions and make sure to use a valid 
e-mail address.
Commercial version: You receive the license key via e-mail as well as with 
your invoice from alta4.
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6. Select a language from the pulldown menu below and click "OK".
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introduction

HTML ImageMapper 10 - AJAX is a very easy to use internet publishing extension 
to ArcGIS.
You can publish your GIS maps as interactive HTML maps which allows the user to 
zoom in and out, pan, perform searches over all attribute data, hotlink and much
more.

HTML ImageMapper is a very intuitive, WYSIWYG based software which produces 
astonishing web mapping results within a few minutes. The HTML ImageMapper 
project will work without any server side software and also on CD-Rom or DVD.

This is the easiest most cost effective way to share your GIS online with the 
non-GIS users who only need a browser to view and interact with your maps.

Benfits include:

easy to learn
easy to use
very cost effective
powerful results, rich in features
no special hardware requirements
no programming knowledge required
no web site administration knowledge required
no software to be installed on the server
no plug-ins required on the client
comes with a full year of maintenance
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system requirements

hard-disk space: approximately 3 MB
memory: recommended 1GB RAM
operating system: Windows 2000, NT or XP
GIS software: ArcGIS 9.0 (ArcView, ArcEditor or ArcInfo) or higher from ESRI
browser:

Netscape version 4.7 or higher
Microsoft Internet Explorer from version 5.x
Mozilla version 1.1 or higher
Opera version 6.04 or higher
support of JavaScript
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open HTML ImageMapper in ArcGIS

1. Start ArcMap.
2. Click "Extensions" in the menu "Tools".
3. A window pops up with the available tools. Check the checkbox next to HTML 
ImageMapper 10 - AJAX.

Note: If HTML ImageMapper is not listed in the dialog the installation process 
has not been successful. A potential cause for this is that you have tried to 
install HTML ImageMapper without having main user rights on your system.

The HTML ImageMapper icon appears in the GUI of your ArcMap. If no data has 
been added to the map document, the icon will be greyed out and inactive. It will 
be colored and activated as soon as you add data to the view.

If you are using a demo or EDU version a dialog will pop up each time you open 
ArcMap after the installation. 
Click "Switch" or "Continue".
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belated licensing of a full version

If you are using the demo or the EDU version and would like to change to the 
commercial version you can use the dialog that shows up each time you start 
ArcMap with your old version.

1. Click "Switch".
2. Type in your name and the license key you got from alta4 after you purchased 
the commercial version.

3. Click "register and load".

The dialog will not show up again.
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uninstall

You can uninstall HTML ImageMapper as other Windows software by using the 
Windows Controlpanel.

1. Close ArcMap if the program is still running.

2. Open the Windows start menu (at the left bottom of your desktop) and select 
"Settings" > "System" > "Software".

3. Select the HTML ImageMapper version you wish to remove. Click "Alter/
Remove".
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4. Confirm the following pop ups with Yes or OK.
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quickstart

A wizard based interface guides you through the application. You can also keep
the default settings and press "create map" button right away.

The way from ArcGIS to your online GIS application

Step 1:
Create your map in ArcGIS and load the HTML ImageMapper extension. Do all the
cartography in ArcGIS. HTML ImageMapper will use all the layer and project 
specific properties such as scale dependent layer visibility and sale dependent 
size of symbols and labels.

Step 2:
Choose the map extent in the ArcMap data view or select a specific scale. Start
HTML ImageMapper and select the map size.
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Step 3:
Just use the smart default settings and create the map!

or make detailed settings yourself:

Select "full screen" in order to create a map that spreads over the entire screen.

Step 4:
Choose up to 5 zoom levels. Please be aware that processing time grows with 
each zoom level. The default settings equal 100%, 200& ... You can also set your
individual zoom levels by entering the scale.
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Step 5:
Make your settings for the click actions for up to 5 layers, e.g. Display attributes, 
Link to database ... Select "Searchable" to enable the online user to use the
search function over all attribute data. Select "Create list". Objects can than be
selected from this list in the browser.

Step 6:
Add an infobar with the title of your project and your contact information in the 
comment field. You can also add a logo, scale bar and coordinates.
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Step 7:
Create an overview map. Make sure to hide all layers that are not needed in the 
overview map and view the result by pressing the preview button. Select "Create
Legend" to export the legend from ArcMap.

Step 8:
Select the output directory.
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Step 9:
Create the map!

Step 10:
Browse the result!
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the extension as authoring system

HTML ImageMapper is a pure web publishing tool and an extenstion for ArcGIS. 
The software enables you to publish maps in the map which you previously 
created in ArcMap. Here you edit your map, make the cartography, include labeling
and set scale dependencies of your layers.

When you are satisfied with the appearance of your map in the overview as well 
as at higher scales, then use the web publishing tool HTML ImageMapper.

specify the map size for the output map
web output - position your map in the browser
zoom scales - specify zoom levels
layers - clickable layers, display attributes, hotlinks
infobar - your title, your logo
map gallery
map elements - overview map, legend
extras - save settings, worldfiles, export to GIS
output - grafic formats, output directory, FTP
preview - publish - help
info menu - choose language, report bugs, check for updates
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specify the map size for the output map

Select the map extent you would like to export in the data view. Zoom in, pan or
select a specific scale to display exactly the map extent you want in the data 
view.
Start the ImageMapper dialog with the ImageMapper icon.

A window pops up in which you can select the pixel size of the map section that 
will be exported.

Select "full screen" to export the complete map section visible in the data view.

Select a smaller pixel size to export a smaller map section. HTML ImageMapper will 
centralize the map frame on the map section displayed in the data view in ArcMap.
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Type in a specific pixel size if you do not want to work with the given settings.
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web output

On this tab you define the exact map size and position of your map in the
browser.

Select "full screen" to fill the entire screen with the map. No additional settings 
are necessary.

Select "absolute" to make all settings in pixels.
Specify width and height of the map extent in pixels. Do the same with the left 
and top offset of the map in the browser. A preview of what your settings look 
like in the browser is displayed on the tab.
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Selct "relative" to make the same settings as above as percentages.

EditText of this page (last edited July 14, 2006) [info] [diff]) 
FindPage by browsing or searching



07.11.2006 16:30

Home | Seite zurück | Download | Shop | Kontakt

zoom scales

The "Zoom scales" tab enables the author to set up to 5 zoom levels. Select 
these according to the scale dependend visibility settings of your layers in ArcMap.

By default only the zoom level 100% is active. HTML ImageMapper suggests 
higher zoom levels and gives yout the pixel size of your maps and the zoom level 
in percent.
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Select up to five zoom levels by activating the checkboxes. 
Use the default settings or type in specific scales into the text boxes.

Note: Processing time will rise exponentially the more zoom levels you select 
and the smaller you choose the scale.
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layers

The "Layer" tab contains settings specific to each clickable layer you specify.
You can make up to 5 layers clickable in the browser and select an individual click 
action for each of those. You also specify the attributes to be exported, the map 
tip field and the searchability of layers. A list can be created for each layer by the 
field you specify.

Activate a checkbox and select a layer from the pulldown menu to make it 
clickable. You will find all layers contained in your ArcMap project. Scale 
dependend visibility settings will be adopted by HTML ImageMapper.

Click on the double arrow next to the pulldown menu to make your settings for
the layer.



07.11.2006 16:31

1. Click actions

Select a click option from the upper pulldown menu. You have 5 options:

display attributes,
hotlink,
link to URL,
link to email,
link to database.

Display attributes:
Check the fields you want to include in the attribute table in the browser. 

If the attribute table contains a lot of fields it is often the easiest to deactivate all 
the fields an then pick only the relevant ones and activate the checkboxes.

Hotlink:
All internet compatible multimedi files (GIF-, JPG- oder PNG-Bilder, MPEG- or AVI 
movies, WAV- oder MP3 sound files ...) can be integrated in the hotlink structure. 
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The file name has to be entered into the hotlink field of the attribute table in 
ArcMap. A click on an object in the browser opens these files.

If you select Hotlink another pulldown menu will be displayed underneath in 
which the hotlink field has to be selected.
NOte: After processing of the output files, the hotlink files have to be copied into 
the hot subdirectory manually. You will be notified to do this after the output has 
been processed.

URL-Link:
A click on an object in the map will automatically open the website in the browser 
that has been defined by the URL. The full path name has to be included in the 
according field of the attribute table. If the URL in the attribute field does not 
include "http://" use the checkbox "add http://". The link will them be completed. 
Select the URL field from the pulldown menu.

E-mail-Link:
Die Funktion ist vergleichbar mit Hotlink und URL-Link. Ein Klick auf die Karte öffnet
das Standard-Mailprogramm des Benutzers mit vorgegebener Empfängeradresse.
Diese E-mail Adresse muss in der Attributtabelle eingetragen sein.

Database-Link:
You can include link to your database on the webserver. This is the default 
setting: path/filename?attribute=<<fieldname>>
To include a link to your own database replace path/filename with a valid path to 
the file from which you want to establish the link to your database. Add the name 
of a variable for ?attribute. The word fieldname has to be replaced by a field of the 
attribute table. 
Example: ''showattributes.php?feature_id=<<FID>>
FID is a field in the attribute table.

The link to a database gives you the possibility to always provide up to date 
information for the user. E.g. you can include daily changing results of a weather 
station while the update has only to be made in the database. You do not have to
process the ImageMapper project again.

2. Map Tip Field

As soon as the puts the mouse on clickable object in the browser a small yellow 
infobox is displayed, the so caled map tip. This field is of great importance if you 
have not included labeling of the objects in the browser. The user can then easily 
identify objects in the map without havin to click on each single one.
Use the pulldown menu to select a field of the attribute table as map tip field. By 
default the first field that includes "name" will be defined as map tip field.

3. Create List

Below the click actions menu you find the checkbox Create List. Activate the 
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checkboy to create a list of the objects of this layer. Then select a field from the 
attribute table after which the objects will be listed. In the browser the user can 
click on list elements to zoom to to objects in the map.

4. Display Copyright Information

HTML ImageMapper recognizes copyright informationen included in the metadata 
of each layer in ArcCatalog Metadaten. Activate the checkbox to display this 
information in the browser.

EditText of this page (last edited July 16, 2006) [info] [diff]) 
FindPage by browsing or searching



07.11.2006 16:31

Home | Seite zurück | Download | Shop | Kontakt

infobar

The infobar is displayed at the top of the page in the browser. Select the 
elements you would like to include in the infobar.
You can view your settings in the preview window included in the infobar tab.

Add infobar:
You can display or hide the infobar jus as you like. Activate or deactivate the 
checkbox "Add infobar" on the left half of the infobar tab.

The following settings can only be made if you activated the "Add infobar"
checkbox.

Title:
Type in the title of your HTML ImageMapper project. The phrase "HTML 
ImageMapper 10 -AJAX" is displayed here by default.

Comment:
Type in your author or copyright information. 
"Created with HTML ImageMapper 10 - AJAX" appears here by default.
If you would like to provide a hyperlinked URL simply include an HTML tag such as:
<a href="[www.mywebsitecom]"target="_parent">[My Web Site]</a>.

Coordinates:
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Display the coordinates of your HTML ImageMapper project in the infobar.

Scale bar:
Activate the checbox to include a scale bar.

Display Logo:
Activate the Checkbox, click the button "Choose logo" and select a logo from a
directory.
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map gallery

Publish your HTML ImageMapper project in the alta4 map gallery!
Enter your data into the text boxes of the map gallery tab. All the rest will be 
done automatically.
As soon as you published your project and a user opens it for the first time in the 
internet the alta4 server receives a message which includes your IP adress. The 
map gallery entry will then be made for you. The alta4 server will also count the 
hits of your website. The more hits you get the more popular your project is 
considered and will be ranked higher in the gallery.

1. Activate the checkbox "Publish in the alta4 Geoinformatik AG Map Gallery.
Note: By doing this you agree to the fact that the data you enter, your IP 
adress plus spatial extent, coordinate system and scales of your map will be 
reported to the alta4 server.

2. Fill in the text boxes and select an industry in which your HTML ImageMapper 
10 - AJAX project fits best.

Every map gallery visitor gets the chance to vote for a map gallery entry. The 
entry with the best voting results is considered the most interesting project.

Note: Only public projects can be entered in the gallery. ImageMapper 
projects that can only be accessed by a limited group of people in the intranet 
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cannot be posted in the gallery.
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map elements

On the "Map Elements" tab you can make your settings for the overview map and 
legend. Beginning with version HTML ImageMapper 10 - AJAX you can customize 
the look of your overview map in the ImageMapper authoring system. 

1. Overview map

Activate the checkbox "Create overview map". Set the width of the map in pixels 
or use the default setting of 250 px.

The overview map often looks crowded when all layers included in the project are 
displayed on it. Therefore select only a few layers to provide a good overview 
over the map.
If you have a lot of layers to choose from it is often the easiest to deactivate all 
layers and reactivate only the ones that are needed.

Click "Preview" to view the result of your settings.
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2. Legend

Activate the checkbox "Create legend" to export the legend previously added to 
the layout view in ArcMap.
If you have not added a legend in ArcMap so far you will be asked if you would 
like to do that at this point. Click "OK" and add the legend to the layout view. 
Then go back to the data view. You will automatically jump back to the mask in 
the ImageMapper authoring system where you left it.
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extras

Save your settings in the HTML ImageMapper authoring system to reload them 
later for a different project or to use them in the batch mode. 
You can also make your settings for the georeferenced tiles, so called mega tiles, 
on this tab. Mega tiles are created during the processing of your ImageMapper 
project and will be exported to the output directory gis as long as worldfiles are 
created.

1. Save / Load settings

Click "Save" and select a directory where you want to store the settings file. It will
have the ending ".sts".
Click "Load" to reload a settings file that you created earlier to take over the 
settings for the current project.
You can also use the settings file to run HTML ImageMapper in the batch mode.

2. Georeferenced tiles

Select a size in pixels for the georeferenced tiles over the pulldown menu. These 
tiles are also called mega tiles. They are very large tiles that are produced during 
the processing of your ImageMapper project. However they are not needed for 
the presentation of the project in a browser. Therefore they are usually deleted 
again.
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By default the tile size is set to 10,240 pixels. This size proofed to be ideal from 
the performance point of view.
The map tiles displayed in the browser have a width of 256 pixels. 
Note: For performance reasons we do not recommend to work with a tile size 
of 512 pixels.

Export world files
Each graphic format available in the HTML ImageMapper authoring system can be 
exported as world files. This file format additionally stores the coordinates of the 
upper left corner of an image as well as the size of a single pixel. With this 
information an images can be reimported into a Geographic Information System 
and be displayed at the correct position. This is one of the most important 
advantages in the processing of images in a GIS. 
As soon as world files are created the mega tiles will be written to the output 
directory and stored in the folder gis. 
Note: It is not necessary to upload this folder to the server!
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output

Use this tab to make your settings for the output files.

Graphics format
The output graphics (map tiles) can be created as JPG, PNG, BMP oder GIF 
files.

Image Quality
In this section you select settings specific to a graphic format and which will
affect the quality of the exported images. The checkboxes and radio 
buttons will change each time you select a different graphic format.

Database API
The export of database API files enables a user with programing skills a 
variety of customization possiblities. The files include table definitions and 
the search attributes with the map as CSV. An author with programming 
knowledge could for example build his own search function and alter the 
output accordingly. 

An example:
The ImageMapper project is located at
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"http://www.example.com/imagemapper/". 

You look in the produced csv table and find for the city of Trier, for example, 
the url component 

"?showinmap=16_2_2288,1915,4". 

By requesting 

"http://www.example.com/imagemapper/?showinmap=16_2_2288,1915,4" 
or
"http://www.example.com/imagemapper/index.html?showinmap=16_2_2288,1915,4" 

you can reach the specified feature directly.

Select output directory
Click the button "Choose" next to the output path textbox and browse to 
the directory in which the files will be saved. The home directory of the 
current user is selected by default. This directory is specified in the profile of
each user.

FTP Upload
This function makes the upload of your project to the server a lot easier. 
Activate the checkbox "upload via FTP".
Enter the server name, user name and password as well as the relative 
path (relative to the FTP server) to the output files in the textbox in the 
lower left corner. 
'Note: Only upload the folder web from the ImageMapper output directory. The 
folder gis'' contains large georeferenced tiles, so called mega tiles, which 
are not needed on the server since they are not required for the 
presentation of your project in the browser. 
Also note that the directory on the server has to be created before the 
upload. 
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preview - publish - help

There are five main buttons that are visible on all tabs.

Back button:

This button takes you back to the settings of map extent and size at any time.

Publish map:

Click this button to process the HTML ImageMapper output files after you have 
made all settings. The files will be written to the output directory you have 
specified on the "output" tab. This can take a few minutes to several hours 
dependend on how many zoom levels you included. The processing time is also 
extended if the original data is not stored locally but on a server.

Preview:

We suggest to use the preview function to view the result of your settings in the 
browser before you process the complete output files. You might want to make 
changes after you viewed the preview.
The following functions are not available in the preview:

Zoom
Navigation with the overview map
Simple search
Advanced search
Lists

Help:

The help button takes you directly to the HTML ImageMapper Wiki.

Cancel:

Press this button to exit the HTML ImageMapper authoring system without 
creating output files.
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info menu

The info menu can be started with the info button on the right side of the 

ImageMapper icon. 

The menu contains license information, copyright data, contact information and 
some additional settings.

Language version
Select the language for the !HTML ImageMapper GUI. Your settings will be applied
as soon as you close the info dialog.

Search for updates automatically
Activate the checkbox to automatically check on the availability of a new build,
each time you start ArcMap. If the is a new build available you receive a 
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notification. Confirm the notification to use the patch update. In this case the new
build will be installed automatically. You do not need to uninstall the old version of
HTML ImageMapper 10 - AJAX!.

Check for updates
Use this button to check for updates if you have not activated the checkbox 
"Search for updates automatically".

Report HTML ImageMapper error
Use this button to report malfunctions of the HTML ImageMapper software. Please
provide as much information as possible, including screen shots so that we can 
reproduce the problem. Your contact data is also appreciated.
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view your HTML maps in a browser

When HTML ImageMapper has finished exporting, you will be asked if you want to
view your results immediately in your default browser.
However you can also open those pages manually:

1. Browse to the ouptput directory in your Windows Explorer.
2. Double click on the file index.html in the web folder.
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browser performance differences

HTML ImageMapper 10 AJAX is a Javascript driven application and - as such - 
depends heavily on the Javascript implementation of the browser. If this is not the
case, one will experience performance penalties. As an example you will notice 
the missing zoom effects in Firefox, Netscape and Safari.

As a performance guidline we can give you:

1. Compatibility

Internet Explorer since version 5.5
Netscape Navigator since version 6
Firefox since version 1.0
Safari since version 1.0
Opera since version 9.0 (tested)

2. Other browsers If applicable the mac versions are included. Browsers not
mentioned above were not available for testing but should also work if they 
include a current Javascript engine. If you experience problems in other browsers 
please give us a note in our bug tracking system at http://www.alta4.com/mantis
.

3. Performance roster

This roster is quite subjective, we have not conducted exact time measurements. 
It is to be seen as a general performance index.

1) Internet Explorer 6

2) Opera 9

3) Firefox

4) Netscape 7

5) Safari 1.2

4. Other factors

As the ImageMapper should be seen as an application rather than as a website it 
is also depended on the overall system status, the performance of CPU, graphics 
card and RAM. Older systems with many open programs show a noticeable 
performance decrease.

5. Cache settings

If you changed your default cache settings you can increase performance by 
resetting them to default behavior. In Internet Explorer go to "Extras" > "Internet
options" > "Settings" and set "look for page changes" to "automatic". This 
activates the page cache and increases performance massively. As said, this is 
default, so you should not have to care about unless you changed the settings by
yourself.
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publish results on a webserver or CD/DVD

Automatic upload via FTP

You can simplify the publishing of your HTML ImageMapper project via FTP upload 
out of the ImageMapper authoring system.

1. Check the box "upload via FTP" in the Output? tab in the ImageMapper 
authoring system.
2. Type in the name of your FTP server.
3. Type in user name and password.
4. Fill in the path to the ImageMapper output you would like to upload. Please 
remember to type in the path relative to the server. From the created output files 
only upload the web directory.
The gis directory contains mega tiles, which are not required for the usage of the 
HTML page. 

Manual upload with FTP software

If you do not want to use the automatic upload out of the HTML ImageMapper 
authoring system you can also transfer the files to the server manually. You need 
FTP software like Cute FTP, WS\_FTP or FTP Voyager.

1. It is a good idea to add a new subdirectory to your homepage.
2. Relocate with the FTP software the content of the web directory from the 
ImageMapper output files to the webserver.
3. To add links to your newly created maps from other pages just add a link to 
"index.html". There is no need to add individual links to each of the files that have
been created by HTML ImageMapper. 

Publish your maps on CD-Rom or DVD

To publish your results on CD do it the same way without the FTP. Just link to the 
"index.html" file.
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configure already published projects

You can configure already published outputs by editing "web/config.js".

We recommend you to make a backup copy of this file before editing.

Important note: When double clicking this file it is executed. Nothing will happen. 
Although to open it you need to either right click and choose "Open with..." or 
open your favorite text editor and open it by "File: Open".

Deactive the print button in the menu bar:

 g_hasPrintKnob = false;

Prevent coordinates display:

 g_hasCoordsDisplay = false;
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your map in the browser

[1] Background map with clickable objects

[2] Overview map

[3] Zoom with the slide

[4] Advanced search over all attribute data

[5] Display attributes

[6] Legend

[7] Lists
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[8] Print

[9] Dashboard

[10] Navigation by the compass rose
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Overview map

Click on the "Overview Map" button in the navigation control below the map to 
display the overview map. It gives the online user better orientation at higher 
zoom levels. The current map extent is marked by crosshairs.

The overview map can also be used as navigation tool. Make a left click in the 
overview map and the this position will be taken as the next center. The map flys 
to the new map extent.

The overview map is nothing else than the map you export from ArcMap to the 
browser, but in a very small scale.

Customize the appearance of the overview map in the map elements tab.
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Zooming in the browser

Zooming in the browser can be performed in several ways:

Zoom by slide
Zoom by mouse wheel
Automatic zoom to an object

Zoom by slide
Move the slide on the lower left corner in the browser up and down to zoom in 
and out of the map. 
Up to five zoom levels with specific scales can be set on the zoom tab in the 
authoring system.

Zoom by mouse wheel
This is the most comfortable way to zoom in and out of the map. Just move the 
mouse wheel up or down to perform the zoom. The map scale will change 
according to the zoom levels specified in the authoring system.

Zoom to object
A zoom to object can be performed in several ways:

click on an object in a list
select an element from the dashboard or
select an object from a search result list.
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Search

HTML ImageMapper 10 - AJAX offers two search functions:

simple search
adwanced search

simple search

The simple search is always visible in the navigation control at the bottom of the 
map in the browser.

Simply enter a search text. The search will be performed over all searchable 
layers, through all attribute data. 
The result will be presented as a list in a pop up window. Click on an item in the 
list to zoom to the object.

advanced search

The advanced search can be started with the "Advanced search" button in the 
navigation control below the map. It will also be performed over all searchable 
layers and through all attribute data. The major advantage is that the search can 
be narrowed down by performing several searches in a row.
1. Select a field of the attribute table to apply the search to.
2. Enter a search text in the text box and click on the magnifying glass.

If you selected a text field in the pulldown menu the search parameter will always
be contains. If you select a numeric field you will be given the choice between 
equals, is higher than and is lower than.
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Display attributes

As soon as you left click on a clickable object in the map the according attribute 
data is displayed in a seperate window. This window is anchored to the clickable 
object in the map and cannot be moved.

There will be one attribute window displayed at a time.

To compare attribute data of several objects you can move the data to the 

dashboard? using the pin needle. 

Press the print icon to print the attribute data. 
The print preview shows the current map extent around the selected object, the 
overview map and the attribute data.

Close the attribute window with the cross. 
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Legend

Click the "Legend" button in the navigation control below the map to display the 
legend in a pop up window.

HTML ImageMapper 10 - AJAX exports the legend to the browser exactly the way 
you edited it in ArcMap.
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Lists

Click on the button "Lists" in the navigation control below the map in the browser 
to display the list window.

If you created more than one list they can be selected in the pulldown menu. 
Below the pulldown menu presents all elements of each list in alphabetical order. 
Click on one of the items to zoom to the object in the map and display the 
attribute data.
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Print

The print function can be used by several elements of the HTML page.

1. Print button in the navigation control

The print preview shows the current map extent the way it can be seen in the 
browser without additional elements.

2. Print attribute data

The print function can be used out of the attribute window. 
The preview window shows the current map extent, attribute data, the selected 
object and the overview map.
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3. Print dashboard elements

The print function can be used out of the dashboard to print its content.  
The preview window shows the attribute data located on the dashboard at that
time.

4. Print search result list
The search result list can be printed as well by pressing the print button of the 
search result window.
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Dashboard

Use the dashboard to collect or compare attribute data of several objects.

The data is listed one below the other on the dashboard. Each entry can be 
minimized or deleted seperately. You can also go to the according object in the 
map by clicking on an element in the dashboard.

 Print elements of the dashboard.

 Zoom to the according object in the map and display the attribute
data.

 Minimize dashboard entry. Only the first three lines are displayed.

 Remove the entry from the dashboard.
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compass_rose

The compass rose is part of the game style navigation. Use the compass rose to
pan the map.

Click on north, west, south or east to move the map extent to the intended
direction.

Click and hold in the center, then move your mouse in the direction you want to 
pan the map. The further away from the center you move your map the faster the
map pans.
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Software License Agreement

This is a legal agreement between you,
the end user, and alta4 Geoinformatik AG
(alta4). By clicking on the ”I Accept”
button in the installation dialog you are
consenting to the terms of this license. If
you do not agree to the terms of this non-
exclusive License Agreement, DO NOT IN-
STALL THE SOFTWARE. For a full re-
fund, return all materials within seven (7)
days to the place where you obtained them.

1. DEFINITIONS:

As used in this License Agreement,
”Software” means the computer pro-
grams either contained on the media
in the package, or which you have
downloaded, together with any ad-
ditional alta4 proprietary programs,
updates or revisions subsequently li-
censed by you. ”Related Materials”
means all of the printed materials and
whatever is in the package for use
with the Software. ”License” means
the grant of certain limited rights to
use and maintain the Software and
Related Materials.. ”Named User”
means (i) a named person or (ii) a
single terminal or a single workstation
of a computer used only by a person
(and not accessed otherwise). In or-
der to preserve and protect its rights
under applicable law, alta4 is not sell-
ing you ownership right to Software.
alta4 specifically retains title to all
alta4 Software and Related Materi-
als, and alta4 licensors retain title to
items owned by them.

2. SINGLE USE LICENSE: USES
PERMITTED:

Software may be used only by a per-
son (and not accessed otherwise) on a
single computer. Software may be in-
stalled onto a hard disk drive. The
Software may also be stored or in-
stalled on a storage devices such as

a network server used only to install
or access the Software on your other
computers over an internal network;
however, you must have acquired a li-
cense for each separate computer on
which the Software is installed or ac-
cessed from the storage devices. A
user license of Software may not be
shared or used concurrently on differ-
ent computers. One backup copy may
be made for each legally obtained me-
dia copy of downloaded copy you have
received, provided that all alta4 and
third party licensor information in-
cluding copyright notices are main-
tained, and possessions of the copy re-
tained by you in a secure location. In
addition, you agree to use reasonable
efforts to protect the Software from
unauthorized use, reproduction, dis-
tribution or publication. All rights
not specifically granted in the License
are reserved by alta4.

3. SITE LICENSE: USES PERMIT-
TED:

Software may be used by all per-
sons associated with licensed com-
pany (and not accessed otherwise) on
a all computers of licensed company.
Software may be installed onto a hard
disk drive. The Software may also be
stored or installed on a storage de-
vices such as a network server used
to install or access the Software on
other computers of licensed company
over an internal network; one backup
copy may be made for each legally
obtained media copy of downloaded
copy you have received, provided that
all alta4 and third party licensor in-
formation including copyright notices
are maintained, and possessions of
the copy retained by Licensed Com-
pany in a secure location. In addition,
Licensed Company agrees to use rea-
sonable efforts to protect the Software
from unauthorized use, reproduction,
distribution or publication. All rights
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not specifically granted in the License
are reserved by alta4.

4. SINGLE USER LICENSE AND
SITE LICENSE: USES NOT PER-
MITTED:

Unless otherwise agreed to in writing
with alta4, you may not

(1) Make derivative works including
but not limited to translation, adap-
tations, arrangement or any other al-
ternation (each of which you would
become the property of alta4 or its li-
censors, as applicable) or make copies
of the Software, except as permitted
above;

(2) Make copies of the Related Mate-
rials;

(3) Use any alta4 product to translate
the product of another licensor unless
you have the legal right to do so;

(4) Allow a grater number o users to
access the Software at any one time
than the total number of uses licenses
of which you have paid;

(5) Rent, lease, sublicense or lend the
Software; Software Copies; Related
Materials or your rights under the Li-
cense or allow access to the Software
for unlicensed internal users; (6) Al-
low third parties to access the Related
Materials or your rights under this Li-
cense or allow access to the Software
for unlicensed internal users;

(6) Allow third parties to access the
Software through any means to ob-
tain reports, maps or other output
(EXCEPT IF YOUR SOFTWARE
IS LICENSED AS A SERVER
FOR UNLIMETED EXTERNAL
(INCLUDING INTERNET) USE);

(7) Alter, decompile (except to the
limited extent that decompilation by
licensed user only, is necessary as the
only available way to achieve inter-
operability with other programs, and

in that situation, any resulting infor-
mation cannot be used in develop-
ing, producing or marketing any soft-
ware substantially similar in expres-
sion to the alta4 product), disassem-
ble or reverse-engineer the Software;

(8) Make any attempt to unlock or
bypass any initialisation system, or
system designed to control Site Li-
cense Users, or encryption techniques
utilized by the Software; or

(9) Alter, remove or obscure any pro-
prietary legend, copyright or trade-
mark notice contained in or on Soft-
ware or Related Materials.

5. DURATION:

This License Agreement is effective
from the day you open the sealed
media package or download and con-
tinues until terminated. If you fail
to comply with any provision of the
License, termination is automatic ,
without notice from alta4 and with-
out the necessity for recourse to any
judicial authority. Upon termination,
you must destroy the written materi-
als and the Software. alta4 con also
enforce its other legal and equitable
rights.

6. GENERAL:

This Agreement represent our en-
tire understanding and agreement
regarding the Software, and Relates
Materials a, and supersedes any prior
purchase order, communications,
advertising or representation, and
may only be modified in a written
amendment signed by an autho-
rized alta4 representative or by a
specific prior or subsequent written
agreement between the parties. If
any provision of this Agreement
shall be unlawful, void or for any
reason unenforceable, that provision
shall be deemed severable from, and
shall in no way affect the validity
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or enforceability of, the remaining
provisions.

LIMITED WARRANTY:

7. COVERING THE PHYSICAL ME-
DIA AND PRINTED MATERIALS:

Alta4 warrants to you, the original
licensee, that the media on which
the Software is recorded and free
from defects in materials and work-
manship under normal use and serve
FOR A PERIOD OF NIENTY (90)
FROM THE DATE OF LICENSE
PURCASE as evidenced by a copy
of the receipt. Alta4’s entire liability
and your exclusive remedy as to de-
fective media or Related Material(s)
shall be, at alta4’s option, either re-
turn of the license purchase price or
replacement of the media or Related
Materials(s). Each defective item,
along with proof of license purchase
and date, must be sent in a traceable
manner, to alta4 Geoinformatik AG,
Frauenstr. 8-9, D-54290 Trier, Ger-
many.

8. DISCLAIMER REGARDING THE
SOFTWARE, DATA AND RE-
LATED MATERIALS:

The Software and the Related Ma-
terials are provide ”as is”. Except
as may otherwise be expressly set
forth herein, alta4 makes no repre-
sentations or warranties, express or
implied with respect to the Software
or Related Materials, including by
way of example and not limitation,
the implied warranties of title, mer-
chantability and fitness for a particu-
lar purpose. By way of further exam-
ple and not limitation, alta4 makes
no representations or warranties, ex-
press or implied, with respect to the
accuracy, reliability or completeness
of the related materials. The entire
risk as to the use of the software, the

data and the related materials is as-
sumed by you. In no event shall alta4
be liable to you or any other per-
son, regardless of the cause, for the
effectiveness or accuracy of the Soft-
ware the related materials or for any
special, indirect, incidental or conse-
quential damages arising from or oc-
casioned by your use of the Software
or the related materials, even if ad-
vised of the possibility of such dam-
ages. In the event the foregoing is
found by a court of competent juris-
diction to be ineffective, you hereby
agree that alta4’s maximum liability
for any claim arising in connection
with the software or the related ma-
terials (whether in contract, tort, in-
cluding negligence, product liability
or otherwise) shall not exceed the li-
cense fees paid by you with respect
to the software and/or Related Ma-
terials at issue. Some states do not
allow the limitation or exclusion of in-
cidental or consequential damages, so
the foregoing provision with respect
to excluding or limiting such damages
by not apply to you.

9. ACKNOWLEDGEMENT:

You acknowledge that you have read
this LIMED WARRANTY, under-
stand it, and agree to be bound by its
terms and conditions. You also agree
that

(1) No oral or written information or
advice given by alta4, its dealers, dis-
tributors, agents or employees shall
in any way increase the scope of this
Limited Warranty, and you may not
rely on any such information or ad-
vice.

(2) Unless a written governing agree-
ment signed by you and alta4 ex-
ists, this License Agreement is the
complete and exclusive statement of
agreement of alta4 and you, and su-
persedes all proposals, oral or writ-
ten, and any other communications
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you may have had prior to purchas-
ing your license.

(3) Except for the price and deliv-
ery terms agreed upon by both par-
ties, the terms and conditions of this
License Agreement shall supersede
those set forth in any purchase or-
der where the purchase order conflicts
or is inconsistent with or adds to the
terms and conditions of this License,
and those supersedes purchase order
terms and conditions shall be null and
void.

(4) If your organization has pur-
chased a multiple user License, you
agree to assure that copies of this
License Agreements are distributed,
read and agreed to by each person us-
ing a licensed product.

10. GOVERNING LAW:

This Agreement shall be governed by
the laws of the Federal Republic of
Germany. Place of jurisdiction is
Trier, Germany.

For any questions regarding the software
and the license agreement, please contact
alta4:

alta4 Geoinformatik AG
Frauenstrasse 8+9
D-54290 Trier
Germany
http://www.alta4.com
imagemapper@alta4.com
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restrictions of the non-commercial versions

Restrictions of the Demo-Version

The Demo Version is valid for 30 days. The time runs from the day you
downloaded the HTML ImageMapper 10 - AJAX.

During those 30 days the version has the following restrictions:

Notification about the usage of a demo version in the map (in 50% of the
tiles)
Display of the alta4 logo instead of displaying attributes for 10% of the
objects.
Permanent link to the alta4 homepage in the output.

You are not permitted to use HTML ImageMapper for commercial purposes or 
delete the phrase "Created with HTML ImageMapper 10 - AJAX by alta4" in the 
comment field of the infobar.
However you are allowed to publish maps that have been created with the demo
version.

Restrictions of the EDU version

The Edu-Version only has one restriction: As with partial versions you are 
permitted to publish maps that have been created with an EDU version. You are
not allowed to delete or change the note "Created with HTML ImageMapper 10 - 
AJAX by alta4" in the comment field or use HTML ImageMapper for commercial
purposes.
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tips and tricks

optimizing the appearance of the map
using the HTML ImageMapper batch mode
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optimizing the appearance of the map

Basics

When creating the overview map you have to consider, that it has a much 
smaller scale than the original map. This has an impact on the appearance of 
symbols and lables. While a symbol can look good in a certain scale, it can appear 
too large in a much smaller scale.

The following example shows a map in a scale of 1:20,000,000 (a) and in a scale 
of 1:150,000,000 (b).

(a)

(b)

The symbols in (b) are obviously oversized.
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The HTML ImageMapper generates the overview map of the selected section 
according to the width (130px in this example) you have specified.

Solution

In ArcGIS you have the option to set a reference scale for each layer. For this 
purpose you have to go to the tab 'Display' in the layer properties an click on 
Scale symbols when a reference scale is set.

Right click the data frame and set the reference scale:
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The symbol size changes immediately in reference to the scale.
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using the HTML ImageMapper batch mode

This chapter will describe how to use the batch mode of the HTML ImageMapper.
The batch mode was designed for automating the HTML ImageMapper project
processing.

First of all, you will learn how to run the batch file using the Visual Basic Editor. 
Further on, a description of the included example will follow. It contains the 
optional ability to be executed and processed within the start of ArcMap.

Setting up the connection between the batch file and the Visual Basic Editor
Description of the batch mode example
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Setting up the connection between the batch file and the 
Visual Basic Editor

1. The HTML ImageMapper has to be installed.
2. Launch ArcMap and open your project.
3. Start the HTML ImageMapper dialog and adjust the parameters as you want to.
4. Save the parameters on the settings tab of the HTML ImageMapper authoring 
system and create a settings (batch) file. It will have the ending ".sts".
5. Close the HTML ImageMapper dialog.
6. Save your ArcMap project.
7. The next step is to enable the automatic start up using the Visual Basic Editor.
You will find the Visual Basic Editor in the menu Tools -> Macros -> Visual Basic 
Editor.
Choose your ArcMap project using the "Project" window and double click "ArcMap 
Objects" -> This Document".

8. Insert the following code:
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9. For using the code, the library "ImageMapper.dll" has to be embedded.
Therefore, choose the menu Tools -> References and select "ImageMapper.dll".

10. Save the preferences of the Visual Basic Editor.
11. Start the new program using Run -> Run Sub/UserForm. A new HTML 
ImageMapper output will be generated.
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Description of the batch mode example

1. Included Files

The included HTML ImageMapper batch mode example comes with a lot of files 
and directories.

batchDemo.mxd:
This is the base project file. It also contains the VBA script for executing the 
Batch-Mode.
imBatch.sts:
This file stores all the HTML ImageMapper preference settings and is 
therefore the basis for the batch project.
Note: In line 89 there is a path declared. This declaration has to be 
adjusted to fit with your file system. Insert here the path to the folder 
"!HTMLOutput" which comes with the batch example.
runBatchMode.bat:
A double click on this file will launch ArcMap and the value of the file 
"!runBatchMode.ini" will be checked. If the ini-value is true, the batch mode 
will be executed. As soon as the batch mode is finished, Internet Explorer 
will start automatically and the created HTML ImageMapper output will be 
displayed.
Note: The paths included in the file have to be adjusted as well.

runBatchMode.ini:
This file contains only a single word. As long as it is "false", the batch mode 
will not be executed. Simply edit this file with notepad or a similar text
editor.
!HTMLOutput:
This subdirectory will contain the HTML ImageMapper output after a 
successful HTML ImageMapper operation.
cities.shp:
This shapefile is used as the basic data for the example project. It is not 
included in the data of the batch example but can be found in the sample 
data of ESRI corp., that comes with every ArcGIS license. (-> esridata)

2. Description of the used functions

Private Sub ExitApp():
This method shuts down ArcMap.
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RunInBatchMode():
This method checks the value of the file "!runBatchMode.ini". The value is 
the whole content of the file. If the value is "false" the batch mode will not 
be executed. This is the default, so that you are able to check and adjust 
the pathnames.
NOTE: You have to adjust the path from the .ini file in the function 
according to your own file system.

MXDocument_OpenDocument():
This method will be executed along with the loading of the ArcMap project. 
This function checks the value of the method "RunInBatchMode()". If the 
value is true, the batch mode will be executed and start up the processing 
of an HTML ImageMapper project.
NOTE: You have to adjust the path from the file !imBatch.sts in the 
method according to your own file system.

3. The Procedure

1. Open the file !batchDemo.mxd in ArcMap.
2. Adjust the source of the layer file according to your own file system.
3. Start the Visual Basic Editor using Tools -> Macros -> Visual Basic Editor.
4. Choose the project batchDemo.mxd in the project window. Expand the tree 
and double click "This Document" in the directory "ArcMap Objects". This will show 
up the VBA code in the window on the right.
5. Adjust the pathnames contained in the code as required for your file system.
There are adjustable pathnames in the functions RunInBatchMode() and 
MxDocument_OpenDocument(). You will find further information in the chapter 
"Included files".
6. Adjust the pathnames in the files !imBatch.sts and RunBatchMode.bat.
7. Change the value of the file !runBatchMode.ini to "true".
8. Save and close the project.
9. Open the file !batchDemo.mxd again. This time, the batch mode is enabled 
caused by the change of the value from the file !runBatchMode.ini. An HTML 
output will be generated, saved to the folder !HTMLOutput and shown in your 
browser at once after finishing. Alternatively you can launch ArcMap and the batch
mode by double clicking the file RunBatchMode.bat.
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Localization

HTML ImageMapper is currently available in the following languages:

Both the language of the authoring system as well as the language of the web 
client can be modified. Languages are defined in language files. One for the 
authoring system (the extension): .txt, and one for the language used in the 
browser application (.js).

The Exension GUI's language

To edit a language, please use windows explorer to navigate to the directory 
named "ArcGIS / ImageMapper / language".

The following language files are included:

The Web Client's language

The browser based web mapping client has a few controlls which contain text 
which also can be localized. The web client's localization files are placed in the
subdirectory languages.
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To edit one of the existing language files, follow the instructions provided in Editing 
Localization Files. When done editing, save it using the same name in order to 
overwrite the old file.

To add a new language, open an existing language file, edit it and save it under a 
'new' name. Let's say, open english.txt and save under 'chinease.txt'.

Please share your work with others: email edited and new language files to 
imagemapper@alta4.com. We will include language files into the next software 
update and by doing so will distribute them to other users.

HTML ImageMapper will recognizes new languages automatically upon starting 
the software. Go to the Info menue to chose your newly edited or added 
language file.

Attention: New language files are not recognized during the setup process. 
You need to manually select them from the info menue's dialog as described 
above. -

EditText of this page (last edited September 27, 2006) [info] [diff]) 
FindPage by browsing or searching



07.11.2006 16:37

Home | Seite zurück | Download | Shop | Kontakt

Editing Localization Files

Localization Files are located here

To edit a localization file, please open the file in a text editor like Windows 
Notepad or UltraEdit. Let's say, open english.txt.

You may now translate everything but the comments. Make sure to keep the
structure of the document. Do not cange the order in which the elements are
placed.

For example, an headline or comment line looks like this:

*****fraZooming**** MUST NOT BE TRANSLATED. 
TRANSLATE THE NEXT LINE!

Save your settings and send them to alta4 in order to share your work with
others.
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Do I need to install additional map server software?

No, there is no map server software required at all. HTML ImageMapper produces 
complete HTML/JavaScript projects that do not require any additional software. 
Therefore you can open the output from a CD or DVD, as well as your hard disk, a 
network drive or the internet /intranet from a server. Really simple, isn't it?

Do I need plug ins or Java in the browser?

The maps are created to be viewed in a browser. That means that you need a 
browser software to view them. However the system requirements are pretty
small. All you need is JavaScript. No plug ins are required.

Are there any limitations with the demo version ? and with the
commercial version ?

Yes, there are limitations with the demo version. No, there are no software
limitations with the commercial version. However, hardware restrictions may 
apply: for processing large amounts of data you need a good PC or workstation 
with enough memory and disk space.

Any information regarding the maximum geographic extent and 
zoom levels supported by this product ?

There is no technical limitation regarding the maximum geographic extent. Five (5)
zoom levels are supported. With the new version 10 you can freely set the scale 
of each zoom level (in previous versions you were limited to fixed scale zooming 
by the factor of 2. Let's say you started at a scale of 200.000, then 4 zoom levels 
would bring you to 100.000, 50.000 and 25.000). Now you can go from 200.000 
to 75.000 to 30.000 to 10.000 to 5.000 or whatever you like.

Is raster data supported ?

Yes. Which ever format you can load into and display in ArcGIS can be exported 
using HTML ImageMapper. However, raster can obviously not be one of your 
interactive layers you can query and identify.

Installation of HTML ImageMapper 10 – AJAX (10.0.20): Error
occurs when starting HTML mageMapper 10 – AJAX.

18.07.06: Currently HTML ImageMapper 10 – AJAX has to be cancelled after an
apparently correct installation process. To do: Browse to the installation directory
in your Windows Explorer. From there go to \Bin\ImageMapper\im\language and
open the file language.ini with an editor. Please insert the word false in the first
line, and the word english into the second line. Save the file language.ini. 
The error is fixed in version 10.0.21 and is available for the Download. Update
10.0.20 to 10.0.21 by using automatic patch update: Customers which used the 
patch update mechanism, we would like to check if the file langugae.ini contains 
the value false in the first line and the value english in the second line. If not, we 
would like to ask them to change these.

Program Error Number 406 ?
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To resolve the problem please add the followind DWORD to windows registry:
HKEY_CURRENT_USER\Software\ESRI\ArcMap\Settings\PreloadVBA=1. 
For a more detailed description, please refer to:
http://support.esri.com/index.cfm?fa=knowledgebase.techarticles.articleShow&d=26333

Program Error Number 429 ?

To resolve the problem, please refer to:
http://support.esri.com/index.cfm?fa=knowledgebase.techarticles.articleShow&d=29463

I have an older version (3.x / 8.x) of HTML ImageMapper. How
can I migrate to version 10?

We offer migration from older versions to the latest version at a special price. For 
details about Please refer to our migration offers page.

When I buy a new license of HTML ImageMapper 10 or migrate to
version 10, does it include maintenance?

Yes, both migrations to version 10 and a new license of version 10 includes 12 
months of maintenance. For example, a new license of HTML ImageMapper is 
available for $1.995 and includes 12 month of maintenance at a value of $350.

alta4 GPS PhotoMapper and alta4 HTML ImageMapper

GPS PhotoMapper layers can be exported similar to conventional ArcGIS layers. If
the "Click actions" option is "Display attributes", the photo appears as a 
thumbnail in the attribute window. By click on the thumbnail, the photo is shown
in large.
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Product History

What's new? What has been resolved?

The numbers up front correspond to the ticket IDs of our bublic bug tracking
system.

Please excuse the mix of languages.

HTML ImageMapper 10-AJAX - 10.0.22

==================================

0000236: Authoring system (ArcGIS extension) -- image mapper 10 will not
install
0000210: Authoring system (ArcGIS extension) -- Druckknopf ein- und
ausschaltbar
0000178: Web Client (HTML/JS) -- Browser-Window-Resize führt zu
unschönem Ergebnis: Anwendung nicht bedienbar
0000257: Web Client (HTML/JS) -- Reload bei Fenstergrößenänderung
funktioniert nicht im Firefox
0000259: Authoring system (ArcGIS extension) -- under "layers" checking 
and unchecking fields does not stick.
0000185: Web Client (HTML/JS) -- Autopatch routine not working properly
0000176: Authoring system (ArcGIS extension) -- Reiter "Zoommaßstäbe"
umbenennen in "Zoomstufen"
0000253: Authoring system (ArcGIS extension) -- createitem_dataCache: 
Features fehlt das "name" Attribut (Testversion 10.0.200???)
0000121: Authoring system (ArcGIS extension) -- Verdecktes Fenster beim 
ersten Start von ArcMap nach Installation
0000199: Authoring system (ArcGIS extension) -- Reiter Layer, Klickereignis,
Attribute anzeigen: Verlinkung im Filesystem ist mit relativen Pfadangaben 
nicht umgesetzt
0000196: Authoring system (ArcGIS extension) -- Schnelles Schliessen von 
ArcMap mit nicht aktueller Version -> Patch Update ohne Fragedialog
0000211: Authoring system (ArcGIS extension) -- Hotlinks don't work when 
hot link strings contains special characters such as '
0000204: Web Client (HTML/JS) -- map tips don't work at 800%, map tips 
work so-so at 1600%
0000190: Web Client (HTML/JS) -- Kunden-Logo in Infoleiste nicht
transparent setzen
0000198: Web Client (HTML/JS) -- Suche nach Attributen mit Umlauten ist
nicht möglich.
0000208: Web Client (HTML/JS) -- Possibility to remove coordinates from 
the dashboard and the print output
0000214: Authoring system (ArcGIS extension) -- Attribute selection in 
Layer tab not retained
0000207: Authoring system (ArcGIS extension) -- Hot-Link im
Informationsfenster
0000175: Authoring system (ArcGIS extension) -- Pixelangabe ab 2. 
Zoomstufe weglassen
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0000174: Web Client (HTML/JS) -- FF 1.5: Rauszoomen mit Scrollrad 
funktioniert nicht
0000186: Web Client (HTML/JS) -- When trying to print the overview map 
overlaps the region information
0000189: Dokumentation / Wiki -- API: Beispiel-URL-Parameter-Aufruf in 
Dokumentation beschreiben
0000182: Web Client (HTML/JS) -- Per Link auf ein Objekt zoomen und das 
Attribut-Popup öffnen
0000193: Web Client (HTML/JS) -- Übersichtskarte, Fadenkreuz: Die
Darstellung des Fadenkreuzes in gelb ist nicht gut sichtbar
0000194: Web Client (HTML/JS) -- Maßstab in den Druck mit aufnehmen

HTML ImageMapper 10-AJAX - 10.0.21

==================================

0000150: Authoring system (ArcGIS extension) -- Relativangaben nicht
verständlich
0000014: Web Client (HTML/JS) -- Verwendung von Umlauten und "ß" im
Titel

HTML ImageMapper 10-AJAX - 10.0.20

==================================

First Release Version
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